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6 Managing and Planning Appointments 

You can plan and coordinate appointments with Outlook. This information management applica-

tion helps you organize your tasks, appointments and the whole daily work routine from one 
place on your computer. The same also applies of course for your colleagues and employees. 

6.1 Summary from the introductory training material 

The Calendar 

To open the electronic appointment calendar, click the Calendar button in the folder pane 

or navigation bar. For switching calendar views, there are several buttons in the Arrange 

group on the Home tab and the Arrangement group on the View tab. 

Basic settings of the calendar 

Select File menu, Options, Calendar page. Here, you set, for example: start and end time 
of work hours, holidays, time zone(s). 

Entering appointments into the calendar 

You can switch to the date you want using (Strg)+(G) keyboard shortcut. Double-click the 

approximate time in the time bar on the left: a form window is opened, in which you can en-

ter or select data. Alternatively, you can open a new form window in any view via Home tab, 

New group, New Items button, Appointment. To close the window, click Save & Close on 
the Appointment tab in the Actions group. 

Changing an appointment 

To change the length of an appointment, select the relevant appointment. Place the mouse 

pointer on the lower edge of the frame and drag it upward to shorten or downward to pro-

long. If you want to reschedule the appointment, double-click the appointment in the calen-

dar to open the corresponding form window and make adjustments of the date or time 
(Start time or End time). Then click Save & Close. 

Appointment reminder 

By default, you are reminded of an appointment 15 minutes beforehand. To change, in the 

Appointment form window, click the little arrow  of the Reminder button on the Appoint-
ment tab in the Options group and select another time from the list box. 

Recurring appointments (appointment series) 

Some appointments recur, for instance, each Monday or each 8
th
 day of the month. In the 

Appointment form window, click the Recurrence button on the Appointment tab in the Op-

tions group. In the resulting Appointment Recurrence dialog box, make the settings. In 
the calendar, you can identify recurring appoinments by circlular arrows . 

All-day events 

To schedule an all-day appointment, activate the  All day event check box to the right of 

the Start time boxes in the Appointment form window. All-day appointments are shown un-
der the date header (column header) at the beginning of a day just like holidays. 

The to-do bar 

You can display the so-called to-do bar at the right edge of the window via View tab, Lay-

out group, To-Do Bar button, Calendar, People, and/or Tasks. Then, the date navigator 
(calendar), the scheduled appointments, and the task list are displayed there. 
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6.2 Sending the calendar 
via email 

You can send your colleagues an ex-
cerpt from your calendar via email. 

In the folder pane on the left, right-click 
the respective calendar in the My Cal-

endars area. In the context menu, select 

the Share command and then E-mail 

Calendar. Or click the E-mail Calendar 

button on the ribbon (Home tab, Share 

group). 

 

Calendar context menu 
 

Adjust the calendar information in the 

dialog box shown to the right and click 
[_OK_]. 

The calendar is embedded in a new 

email message. Enter the recipient ad-

dress, insert text above or below the 

calendar information, and send the 
message: 

 

Adjusting the calendar information 

 

The email message with the copied calendar information 
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6.3 Saving the calendar on a network or Internet server 

To save the calendar on a network or Internet server, go to the File menu and click Save Cal-

endar. In the following example, the calendar is being saved to the D: drive of the network serv-

er COMP2GHX. It can also be an Internet site, however. Everyone who has access to this folder 
can view the calendar. 

 

Saving the calendar on the network 

Open the dialog box to adjust the calendar information with the [More_Options] button. After you 
save it, other people can import this calendar file (*.ics) into Outlook. 

6.4 Exercises 

Imagine you are in charge of a project in a company and meet with the individual project team 

members in order to discuss their progress and what further action should be taken. In addition, 
your boss wants to be informed about the current status of the project. 

Keep a calendar with the following appointments and settings: The work hours begin at 9 a.m. 
and end at 6.30 p.m. The Day calendar ought to have 15 minute time intervals. (Customizing 

the time intervals: Right-click the time line and select the time interval (for example 15 minutes)) 

1. The talks with the project team will take place on October 9: you have an appointment with 

Ms. Kinner at 9:45 a.m., Mr. Muller is expected at 11:30 a.m., Ms. Hansen at 2 p.m., and 

Mr. Koslowsky at 3.30 p.m. 

2. The description of the appointment will always be Project - status quo. In addition, it will 

include the name of the respective employee. Plan 60 minutes per meeting. Also, set a re-

minder for 30 minutes before the appointment. 

3. The meeting with your boss will take place at 5 p.m. on the same day. It will probably last 

45 minutes. 

4. Once a week, every Monday at 9 a.m., you take part in a one-hour sales meeting. 

5. On February 2, 3, and 4 you are registered for an all-day sales seminar. 
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7 Connected to Exchange 

In large companies and agencies  it is usually no longer enough to use Outlook without a con-

nection to other computers. To make this connection, Microsoft offers the additional program 
Exchange. This requires a computer on which the so-called Microsoft Exchange Server is 

installed. Via the company or agency network, this server communicates constantly with the 
users, the so-called email clients. The connected computers receive the most recent infor-

mation very quickly. Apart from that, the users are provides with several more internal commu-

nication options, e.g.: 

1. Designating a delegate who can process your mails in your absence. 

2. Joint appointment and resource planning via the calendar. 

3. A global address book for all employees allows you to search for email addresses. 

 

Message on the status bar 

Provided that an Exchange mailbox has been set up for you and that your Outlook is also set up 

correspondingly, this mailbox appears in the folder list. The contents of this mailbox folder are 

saved on the Exchange server. If you wish, copies are created on your computer so that you 
can access the data already available even without an Exchange connection, i.e. offline. 

Your personal folders are saved on your computer and only you can access them. Using the 

usual commands, e.g. drag and drop, you copy or move the data between the mailbox folders 
and the personal (local) folders. 

Your Outlook is usually automatically connected to the Exchange Server. In case of a disrup-

tion, you will receive the message  on the status bar at the bottom right. Outlook then 
tries to restore the connection to Exchange at regular intervals. 

The connection to the Exchange server may also be made via the Inter-

net to give employees the opportunity to access the Exchange mailbox 

from anywhere at any time. It can be necessary, e.g. for cost reasons, to 

work offline sometimes and to make a connection again later, for exam-

ple when you are staying abroad. By clicking the button shown on the 
right on the Send / Receive tab in the Preferences group you switch 

offline mode on and off. A message on the status bar at the bottom right 

shows you the mode: . 

 
Send / Receive tab, 
Preferences group 

7.1 Delegation 

With the Exchange server, Outlook is particularly directed to internal communication as well. 

Thus, there is the option of exchanging data with all employees within a company. If you are 
absent, you can assign a delegate to cover for this time. To do this, open the Info page of the 

File menu and click the Account Settings button and select the Delegate Access command 

from the submenu: 
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File menu (cut-out) 

The dialog box on the right is opened. Click the 

[Add] button. 

 

 

The Delegates dialog box 

The global address book appears with all em-

ployees. Select your delegate and click the 
[Add] button: 

 

Adding a name 

Once you have confirmed the selection with [_OK_], you have to define the permissions of your 
delegate in the following dialog box: 
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Defining delegate permissions 

Make sure that the Inbox field doesn't contain None and close the dialog box by clicking [_OK_]. 
In the Delegates dialog box, you will now see the name: 

 

The delegate has been entered 

Click [_OK_]. After that, your mails can now also be opened and processed on the computer of 

the delegate using the following path: File menu, Open & Export page, Other User’s Folder 

button. In the following dialog box, clicking the [Name…] button opens the global address list 

where you select the name. 

 

Opening the global address list 

If the delegate switches to a different view, the inbox of the person who is absent is closed and 

must be called up again in the same way. This can be somewhat inconvenient when the delega-

tion occurs on a frequent or long-term basis. However, it can be avoided by setting up perma-
nent mailbox access as described in the next chapter. 

If the delegate replies or forwards an email on behalf of the person who is absent, this is clearly 
indicated in the sender line: 

 

Sender line of the delegate 
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To make changes to your delegations, open the previous dialog box again, select the respective 
entry and click [Permissions] or [Remove]. 

Setting up permanent mailbox access 

By setting up permanent mailbox access your delegate can have your email folder permanently 
displayed in their own Mail view. You simply have to share your mailbox and define which fold-

ers are displayed with which permissions. The delegate must then add the mailbox to their Mail 

view. In our example, Amy Somerville designates Helen Stewart as her delegate. Helen Stewart 
on the other hand adds Amy Somerville's mailbox to her own Mail view for permanent access. 

1. In the folder pane of the Mail view, 

right-click your mailbox (in our example 
Amy Somerville) and select the Fold-

er Permissions command from the 

context menu. 

2. In the dialog box that opens, on the 

Permissions tab, click the [Add] but-

ton, double-click the person/people to 

select the one(s) you want to grant ac-

cess permission, and confirm your se-

lection with [_OK_]. The name appears 
in the upper part of the Permissions 

tab (here: Helen Stewart).  

Adjusting folder permissions 

3. Select the Permission Level by clicking the drop-down arrow . In the Read, Write, De-

lete Items, and Other areas below it, you can see which permissions the individual levels 

contain. However, you can also activate and deactivate options in these areas yourself. 

 

Defining the delegator's permissions 

4. Close the dialog box by clicking [_OK_]. Helen Stewart has now access to the mailbox. 

We still have to specify which folders the delegate can display in their Mail view and with which 

permissions. In our case, it is the inbox and the delegate shall receive full read/write access. 
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1. In the folder pane, right-click Inbox and select Properties from the context menu. 

2. In the Inbox Properties dialog box, switch to the Permissions tab and select the delegate. 

3. If necessary, select Editor as Permission Level. 

4. Confirm your settings by clicking [_OK_]. The delegate can now add your inbox to their Mail 

view. 

As the delegate, adding the inbox of the absentee to one's own Mail view 

To display the inbox of the person, on whose behalf you want to act, in your mailbox, you have 
to add their mailbox to your Mail view: 

1. On the Info page of the File menu, click Account Settings and select Account Settings. 

2. On the Email tab, select your Exchange account (in our example Amy Somerville) and 

click [Change]. 

 

Selecting the account and clicking [Change] 

3. In the Change Account dialog box, click [More_Settings] and in the Microsoft Exchange 

dialog box, switch to the Advanced tab and click [Add]. 

4. Type the name of the person whose mailbox you want to add into the Add Mailbox dialog 

box (in our example Amy Somerville) and click [_OK_]. 

 
Entering the last name or a distinct first name is sufficient. If Exchange cannot find the 
name in the address list, you'll receive an error message. 

5. The name has now been entered in the Microsoft Exchange dialog box. Close it by cli-

cking [_OK_]. 

 

The additional mailbox has been entered 

In the Change Account dialog box, click [Next] and [Finish] and then [Close] the Account 
Settings dialog box. 
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The mailbox is now available in the folder pane. You open it via the small triangle  to navigate 
to the folders you have permission to access. 

 

Folder pane of the delegate (Helen Stewart) with the mailbox of the represented person (Amy Somerville) 

Removing the mailbox of the absentee from the Mail view 

To remove the mailbox when you no longer need to act on behalf of the other person, go to the 
File menu (Info page), select the Account Settings command from the submenu of the Ac-

count Settings button, select your Exchange account, click [Change], then [More_Settings], 
switch to the Advanced tab in the Microsoft Exchange dialog box, select the account of the 

represented person and click [Remove]. Confirm the question, if you are sure that you want to 
remove the mailbox with [Yes], close the Microsoft Exchange dialog box by clicking [_OK_] and 
the Change Account dialog box by clicking [Next] and [Finish]. 

7.2 Sharing calendars 

In an Exchange environment in the default setting all users can only look at the busy times in 

the calendars of colleagues via the scheduling assistant (page 80). To see or change the de-

tails, a calendar needs to be shared. The notification about the sharing of a calendar is given 

with a message. A distinction has to be made between two approaches: 

 You ask the email recipient to share their calendar with you (Sharing request), and/or 

 You give the email recipient permission to view details in your calendar (Sharing invita-
tion). 

In the calendar view, on the ribbon, click the button on the right on the 
Home tab in the Share group. Outlook composes a new message with 

the sharing request or invitation. Enter the recipient's address or select 

it. Now, set the type of calendar sharing, you can also activate both 

check boxes: 

 

Home tab, 
Share group 

 Request permission to view recipient’s Calendar. 

 Allow recipient to view your Calendar. 

 When you activate the lower check box, use the Details list box to determine whether only 1.

the availability, limited details or full details will be shown. 
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A message with the calendar sharing 

 When activating the upper check box, you'll send the recipient an email request to 2.
share their calendar. The recipient answers this request via the Allow or Deny buttons. 

If they allow it, the details can be adjusted in the window that opens and a message can 

be added in the text area. 

 Click the Send button and confirm the question whether you want to share the calendar 3.

by clicking [_Yes_]. 

 

Sharing the calendar? Yes! 

 

Adjusting the calendar permissions 

Calendar permissions 

To adjust or remove the sharing 
of your calendar, click the Calen-

dar Permissions button on the 
Home tab in the Share group. 

 

Home tab, 
Share group 

In the dialog box on the right, first of all, add or select 

the respective name in the pane at the top. Now, set 
the various options for Read, Write, Delete items 
and Other. 

Clear overview of shared calendars 

Assuming you want to coordinate the appointments of your colleagues to collaborate with them 

on a team project and they have shared their calendars with you for this purpose. With its 
Schedule view, Outlook makes it possible for these calendars to be displayed simultaneously 

one below the other providing a clear overview. 
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1. On the Home tab, in the Arrange group, click the Schedule View 

button. 

2. In the lower left part of the calendar section, successively type the 
names of the colleagues into the Add a Calendar field or select 

them via the address book . The calendars are now displayed 

below each other with your own calendar at the top.  

 

Home tab, Arrange group 

 

 

All calendars are shown in Schedule view 

3. A timeline is located above the calendars; based on a blue bar you can quickly see when at 
least one person is not available. 

Depending on their sharing details, your colleagues' calen-

dars will only display busy times (for instance in the Frank 

Dreyersdorff example) or further information such as the sub-

ject. If only busy times are displayed you can send a sharing 

request by clicking the  icon below the name. With the ap-
propriate authorization you can also edit the appointments. 

If you no longer want to display a calendar, simply remove the 
check mark in front of the respective name in the Shared 

Calendars section of the folder pane. 

 

Hiding a calendar 

7.3 Meetings 

Joint appointment planning with Outlook in an Exchange environment is an important area of 

application. When planning a meeting, you can, for example, use messages to invite the at-
tendees and reserve rooms and other resources. 

To set up a new meeting, in the calendar view, click, for example, the New Meeting button on 

the Home tab in the New group. Determine the attendees using the [_To…_] button, type in a 
Subject, and select the Location using the [Rooms…_] button, e.g.: 
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New meeting 

While setting up the meeting, the availability of a room is already visible in the lower part of the 
Room Finder task pane. 

 

Once you have selected and typed in all content, you can send the invitations: Click the 
Send button, or press [Ctrl]+(Enter) the key combination. 

The invited participants receive a meeting request via email. Using different buttons in the 

Respond group on the Meeting tab, the invitation can be answered: Accept, Tentative, De-
cline, Propose New Time, e.g.: 

 

Replying to a meeting request (if necessary, open the calendar preview via  in the text area) 

In the submenu of the Accept, Tentative and Decline buttons you can select whether you want 

to send your reply immediately, edit the reply before sending, or not send it at all. If the invitation 

has been accepted, the meeting will be automatically added to the calendar of the invitee. The 

organizer of this meeting will receive a notification of the acceptance (maybe tentative) or decli-
nation: 
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The meeting has been accepted 

 
You also receive an automatic acceptance via email from the conference room if it is 

free at the time, or a declination if it is already booked. 

Tracking 

In the acceptance above, you can partially track the status of the 

attendees in the bottom left part of the email header; however, Out-

look also offers you more detailed information on their status. To get 
this, switch back to the Meeting window. On the previous page this 

new meeting was planned in Appointment view. Once you have 

sent the invitations, the Tracking button is added to the Show group 

on the Meeting tab. With a click on this button you open the following 

view, e.g.: 

 

Now, there are three buttons 

on the Meeting tab in the 
Show group 

 

The meeting in Tracking view 

The Scheduling Assistant 

Now, in the Show group, click the Scheduling Assistant button. To schedule meetings, addi-

tional options are provided in this view. Here, differenttly colored markers provide a good over-
view of the calendars of the planned attendees and resources (here Room 2). You can also add 

more attendees and resources and make changes and remove items. People who haven't sent 
a reply yet, are displayed as  Tentative: 
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Scheduling Assistant view 

Using the Appointment button in the Show group on the Meeting tab, you switch back to Ap-
pointment view. 

You can also use the scheduling assistant as early as for planning a meeting to see from the 
first when your colleagues are available. To do so, open a new meeting (Home tab, New group, 
New Meeting button) and click the Scheduling Assistant button to open the assistant. 

In the left part of the window, place the cursor in the Add a name 

here field, type in the respective required attendees including the 

room or select them via the  Address Book button (Meeting 

tab, Attendees group), and complete each entry by pressing the 

(Enter) key. 

 
Entering the attendees here 

Use the scroll bar to navigate through the possible times or select your favorite date and time in 
the Start time fields. The bars show you, which attendees have appointments at what times and 

you can schedule your meeting accordingly. 

 

The appointments of all attendees are evident here 

Click the Appointment button (Meeting tab, Show group) to switch back to Appointment view 

where you can enter a subject and a message in the text area and send your request. 
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Cancelling a meeting 

If a meeting needs to be cancelled ahead of schedule, it is not enough for the 

organizer of the meeting to just delete the meeting from the calendar. Here, it 

is of course necessary to inform all the attendees and to release the booked 
resources again. To do so, in the meeting window, click Cancel Meeting 

button on the Meeting tab in the Actions group. Maybe change the subject 

and write additional information in the text area of the message. Then finally, 
click the Send Cancellation button. Only then will the meeting be cancelled! 

 

Preparing the 
cancellation 

message 

 

Cancelling the 
meeting 

7.4 Automatic reply to email messages 

You can set up Microsoft Outlook so that everyone who sends you an email message automati-

cally receives a reply with the information that you are currently out of office or that your reply 

may be delayed. Automatic replies can also contain further information, such as alternative con-

tacts. 

To set up automatic replies, in the main window, click the button on the right 
on Info page of the File menu. The following dialog box appears. Activate 

the  Send automatic replies option: 
 

File menu, 
Info page 

 

Setting up automatic replies 

Type the reply text into the large white box and you can use the buttons above to format this 

text as well. The messages are replied to differently, depending on the sender being inside or 
outside your organization. For that, two tabs are available. On the Outside My Organization 

page you can also set whether the replies are only sent to senders from your contact list or to 

anyone: 

 

Two tabs 
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Once you have made the settings and have entered the text, close the dialog box by clicking 
[_OK_]. On Info page of the File menu, you can now see that the Automatic Replies feature is 

switched on: 

 

The automatic replies are switched on 

Using the corresponding button you deactivate this feature and with a click on the large button 
you open the Automatic Replies dialog box again. 

7.5 Exchange and address books 

The Exchange Server manages both internal and external addresses in the so-called Global 

Address List. This means you cannot only communicate within the  company but also external-

ly via email. This address list is maintained and managed by your company's administrators. As 

a general rule, employees cannot change anything in the company address book. If you should 

discover mistakes, inform the experts who will then make the necessary changes. 

To use the global address book for a new message (page 21), click the [_To->_] button in the 
message window. The following dialog box appears: 

 

A global address book  

Use the arrow  of the Address Book field to select 

another address book from the list shown on the right. 

As usual, the selected name is applied as the message 

recipient with a click on the [_To->_] button. The [_Cc->_] 
button sets a copy recipient and the [_Bcc->_] field con-
tains a so-called Blind Copy. This means that the recip-

ient cannot see who else is receiving the mail. 
 

Selecting another address book 

http://www.dettmer-verlag.de/


  Schulungunterlage Outlook 2016 Weiterführung Englisch 

  84 Musterseite aus dem Dettmer-Verlag, D-76889 Kapellen 

www.dettmer-verlag.de 

Copying contacts 

Your personal contacts and the global address book are two different files which exist separate-

ly. Your contacts are not accessible to the other employees as they are stored locally. The glob-
al address book (Global Address List) is on the Exchange Server and is used by all company 

employees. However, it is possible to copy contacts from the global address list to your own 

contacts. This is particularly helpful if there are lots of employees in your company but you only 

communicate with a few of them regularly: 

1. Select the respective contact in the global address list. 

2. Right-click the selection. 

3. In the context menu, select the Add to Contacts command: 

 

Selecting from the context menu 

The contact has been added to your personal address book. But please note: Changes in the 

global address list will not automatically be applied to your personal address book! You have to 

maintain it yourself. 

In the context menu above, 
there is also the New Entry 

command. You can use it to 
add a new entry, but only to 

your personal address book, 
not to the global address list! 

 

Not possible to make a new entry in the global address list 
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Distribution lists (groups) 

Creating distribution lists in your personal address book 

was described from page 9 onwards. When selecting 

address books in Exchange, you can also include the 
global address lists. In the Address Book: Global Ad-

dress List dialog box shown on the right, the entry 

 is an example of a distribution list. 

 

Global address list (cut-out) 

7.6 Creating polls with voting buttons 

Outlook enables you to easily create polls and check their results. The uses are manifold. Let us 

assume for our example that you have been asked to organize a company outing and want to 

include your colleagues in the individual decisions, such as voting where to eat lunch based on 

a selection of different restaurants to choose from. This can be done by adding voting buttons to 

your email and sending it to the people being asked. The results of the vote will be filed in your 

inbox. 

Adding voting buttons to an email 

1. Switch to the Mail view if you are currently working in another view 

and click the New Email button on the Home tab in the New group 

to open a new message window. 

2. On the Options tab, in the Tracking group, click Use Voting But-

tons and select Custom from the submenu. This option provides 

the possibility to assign your own names to the voting buttons. 

3. If necessary, activate the  Use voting buttons check box in the 

Properties dialog box, delete the default text in the list box behind 

it, and enter the required names for your voting buttons instead. 

Separate them with semicolons (;). 

 

 

Options tab, Tracking group 

 

Entering your own voting buttons 
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4. [Close] the dialog box. In the message window, the information bar below the ribbon in-

forms you that you added voting buttons. 

 

Voting buttons were added to the message 

5. You can now write your email and send it to your colleagues. If you also send the message 

to yourself and reply to it, your choice will also be displayed in the current status (page 87). 

 
It isn't mandatory to create a new email to conduct a poll. You can also answer or for-

ward an existing email and add voting buttons. 

Responding to a poll as recipient 

As the recipient of an email with voting buttons you can either vote in the reading pane or you 

open the email and vote in the message window. 

 To vote in the reading pane, click the following link in the information bar at the top and then 
click your choice: 

 

 In the message window of the opened mail, click the Vote button on 
the Message tab in the Respond group and select your choice from 
the submenu. 

As soon as you have made your choice, the following dialog box ap-

pears in which you can determine whether the response is to be send 
right away or if you want to edit it before sending. 

 

Message tab, 
Respond group 

 

Sending the response right away? 

The  Edit the response before sending option opens a new message window in which the 

recipient's email address and the subject have already been entered so that you only have to 
enter your text. Confirm your selection in the previous dialog box by clicking [_OK_]. 
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Reviewing the voting results 

The voting results of the individual recipients are sent to your inbox as emails. After opening 

such a message, the information bar below the ribbon tells you what choice the sender made, 

e.g. 

 

To review the current status of the vote, double-click the message you sent in the Sent Items 

folder. You can recognize it by the  icon in front of the recipient's name (reading pane off or at 

the bottom) or to the right of the recipient's name (reading pane on the right). If you have 
changed the default location for sent messages, open that folder. On the Message tab, in the 

Show group, click the Tracking button. The information bar below the ribbon shows an 

overview of the results and below it, the current voting results are displayed in a table: 

 

The current status of the poll 

 
The current status of a poll is only displayed if at least one recipient has already re-

sponded. 

7.7 Outlook Web App 

Outlook Web App is the web-based counterpart to Outlook 2016, but with a limited range of 

functions. It enables you to access the Outlook views (modules) directly via a web browser (e.g. 
Internet Explorer or Microsoft Edge). 

Switch to the File menu and open the Info page. Click the link below Access this account on 

the web which you can find to the right of the Account Settings button. Now, your default 

browser opens with Outlook Web App. Enter your user name and password that you have 

received from the administrators. Save the link to use it later independently from Outlook, for 

example in your favorites or in a file on an external storage device. That way you can access 

your Outlook wherever you are, even from computers on which Microsoft Office isn't installed. 
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8 Aufgaben verwalten und delegieren 

In Outlook, tasks are activities that have no fixed time frame but must be carried out neverthe-

less. However, you can enter a target date for completing the tasks, and their priority. Moreover, 
you can monitor tasks and specify what percentage of each task has already been completed. 

8.1 Summary from the introductory training material 

New task 

Activities that have no fixed time frame but must be carried out nevertheless are called 

tasks. In the folder pane or navigation bar, click the Tasks button. You can enter the task di-

rectly into the task list: Click here to add a new Task. 

Completed tasks 

Completed tasks can be marked as complete and then be deleted from the list: Activate the 

 Complete check box on the left of the task line. To delete the task, right-click the task 

and select Delete from the context menu. 

If the Complete check box is hidden you can add it as described on page 46. 

Recurring tasks (series of tasks) 

For a constantly recurring task, open a new Task form window, for example via Home tab, 

New group, New Items button, Task in any view. Press the (Ctrl)+(G) key combination or 

click the Recurrence button on the Task tab in the Recurrence group and, in the Task Re-

currence dialog box, set the data as required. 

To-do bar 

The to-do bar was introduced. It can display, among other things, a list of upcoming tasks. 

Double-clicking an entry in the to-do bar opens the corresponding form window. 

Different views 

No matter what you are doing, Outlook offers you various views in all views (modules). Use 

the buttons in the Current View group on the View tab to choose a suitable setting from a 

great variety. 

8.2 Categorizing tasks 

With the Catagorize button on the Task tab in the Tags group, 

you apply a category to the current task in the task window. Click 
the button and select All Categories in the submenu. The follow-

ing dialog box appears, in which you can also rename, delete or 
add new categories: 

 

A new category is applied in this dialog box 

 

Activating the Color 

Categories dialog box 
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It is also possible to apply several categories to a task at the same time: 

 

Task with two categories 

In the previous picture, we applied a new category 
named Business and the Orange Category to the task 

as you can tell from the two bands below the ribbon. 
 

Adding a new category 

8.3 Assigning tasks 

If you can assign tasks to your employees, do this using the Assign Tasks option: 

1. On the ribbon, switch to Simple List view (page 12). 

2. Double-click the task in question to open the form window. 

3. At the top of the form window, on the Task tab in the Manage Task group, 

click the button on the right. 

4. The form window is extended by the To field. There, you enter the name of 

the person who is to carry out the task. 

 

Manage Task 
group 

 

You can also click the [_To…_] button and select the task recipient from the address book. 

Select the name of the recipient in the following dialog box and click the [_To->_] button. To 
select several recipients, hold down the (Ctrl) key while selecting. 

 

Selecting the task recipient from the contact list: 
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5. Close the address book by clicking the [_OK_] button. 

6. The recipient has now been entered: 

 

A task is assigned to another person 

7. Click the Send button to send the task. 

Based on the  icon in the task list, you can see which tasks you have 

delegated. To view only these tasks, click the Change View button on the 

View tab in the Current View group, and select Assigned. Then, only 

these tasks will be displayed. However, it must always be assured that 
you do not deactivate the check mark in front of  Keep an updated 

copy of this task on my task list when you assign the task (previous 

image). 

 

Connected to Exchange 

When you use Outlook in an Exchange surrounding you get a good overview of the tasks you 
have assigned to other employees and their status. 

If you have not deactivated the  Keep an updated copy of this task on my task list option 

when you assigned the task, you will always see the current status of the task when you call it 
up with a double click: 

 

25% of the task has been completed 

If you have also kept the  Send me a status report when this task is complete option, you 

will automatically receive an email when the recipient has marked the task as complete. The 
task will also be marked as complete in the Tasks view. 
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8.4 Always show tasks 

With the help of the to-do bar you can always dis-
play your tasks. Use the path View tab, Layout 

group, To-Do Bar, and select  Tasks with a 

mouse click as. 

By double-clicking an entry in the to-do bar you 

open the corresponding form window. For tasks 

with an activated reminder  you will only get a 

message if the check box in the Task options area 

of Outlook Options is activated: 

 

You can switch the to-do bar 
on and off 

 

Activating reminders 

8.5 Exercises 

Assuming you are in charge of a project, and every month you perform different tasks which are 

related to the project: 

 Controlling the progress of the task processes, 

 protocolling the material costs, 

 verifying the employees' time accounts and 

 compiling the project-related labor costs per employee. 

 

1. Enter the tasks and choose a due date. 

2. Since the tasks recur every month, set it up as a task series. 
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